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Copyright and License Agreement 

WordCoach is ©1998-1999 by Edwin Bühler.
  

The program WordCoach is shareware.

Edwin Bühler grants a free 30 day license for use of this software (WordCoach),
starting from the date of receipt, after which time said software must be registered
with Edwin Bühler with appropriate compensation and  registration forms. Under no
circumstances may the software be used beyond the  free 30 day licensing period
unless the previously stated conditions have been  satisfied. You must purchase a
separate copy of the software for each Macintosh it  is used on.

Unless explicitly stated in writing, Edwin Bühler does not grant permission to distribute
the software for profit in any form, including but not limited to, electronic  information
service distribution, bulletin board distribution, and magnetic or optical  medium
distribution. Non-profit distribution of the software is acceptable without prior written
notice, providing that the software is not modified in any way, and the complete
works of the software are included in the distribution package.

Edwin Bühler is not responsible for any damage to the purchaser's computer system
or data and in no event will Edwin Bühler be responsible to the purchaser for any
consequential, incidental, or indirect damages (including damages for loss of business
profits, business interruption, loss of business information and the like) arising out of
the use or inability to use the Edwin Bühler product, even if  Edwin Bühler has been
advised of the possibility of such damages. Because some  states do not allow the
exclusion or limitation of liability for consequential or  incidental damages, the above
limitations may not apply to you.

SmalltalkFactory , Edwin Bühler

 Op de Berg 27
 41849 Birgelen
 Germany

 Phone: ++49-2432-4122
 Fax: ++49-2432-4120
 E-Mail: EdBuehler@aol.com

 Web: http://www.smalltalkfactory.de
Online Order Processing: http://order.kagi.com/?GDK
                                                                    



Introduction

This program is a simple word trainer, which helps you to learn foreign
words. For this job, the application is limited to the basic functions. That
means, you must answer a question. Then the program check your answer
and show you the result.

The application is a supplement to a language course or book.
Furthermore it is sensible to use a dictionary (book) parallel to this
program, because in a book you find detailed information for a word.
Often there are example sentences available.
Before you start to learn a lesson, have a look to the new words in the
word list. Look up every new word in an extensive dictionary. So you fix
the first words in your mind.

Every word in a lesson will be tested several times. If you answer all
questions of a lesson often enough, the program will change automatically
to the next lesson. Sometimes words of previous lessons would be tested
again. If you answer wrong, this questions come repeatedly.
If you already have some basic knowledge of the language, it is a good
idea to make your own dictionaries.
Sensible are also lessons with complete sentences. Make dictionaries with
sentences for translating.

Example:

* Wo sind die Streichhölzer ?  Where are the matches ? 
* Ist jemand zu Hause ? Is anyone at home ? 

Installation

First you must decompress the program archive. When you use a 68k Mac,
you must moving the contents of the “CFM-68k Additions” folder into the
systemextensions folder. That is all what you must do for installation.



Basics

This application stores the results of a few users in the result database.
When a user login, the last dictionary, used by the logged user will be
opened. 

GUI Language
When you start the application the first time, a language chooser dialog
appears. Choose the language for the program interface. If you will
change the language later, press the command-key ( ) when you start
WordCoach. Hold down the key, until the language chooser aapears.

Login

At the first start, there is no user in the user list “Users”.  Edit now your
name in the field “User Name”. Then edit a password in the “User
Password” field. Click now on the button “Add New User”. A password
window appears, and you must repeat your password. To login now, click
on the button “Login”.

Next time you will use the application, double click on your name in the
“Users” list. Edit your password in the “User Password” field and click
on  “Login” or press the return key.

First Login

Every user who login first time, must load a dictionary or create one.



Learn Words

First switch the language direction. Use the items in menu Options or use
the picture buttons.

Click on the button “New” around a new to get a new question. In the text
field “Question” is displayed the test word. Input now into the text field
“Answer” the translation. Subsequently, you click on the button “Test”.
Now you can see the result in the result field.
 

The Status bar

The Status bar right of the lesson number, show you how many you have
learned.

Shortcuts

For the buttons New and Test you can use shortcuts.

•New  and N
•Test Return

TIP

Use only the return button. When you press the return
button again, it is the same like the New button.

The program switches automatically to the next lesson, presupposed your
error rate is not too high. You can also select the desired lesson with
"Options>Start with …".

List Words of a Lesson

You can list the words of a lesson, with the menu item “Options->Wordlist”
(  and L). With the popup menu in this window, you can select the lesson.

Load Dictionary 

Select the menu item "File>Open Dictionary " (  and O).
Select a dictionary in the file selection box.

Now the dictionary will be load. The picture buttons change the flags. And
the menu get other items.



Create Dictionary 

Select the menu item "File>New Dictionary " . A file dialog appears. Edit the
file name for the new dictionary. Next the “Language Chooser” appears.
With the two popup buttons you can choose the native and the foreign
language. Now the main edit window appears.

Word to Word
Press  and 1 to create a “Word to Word” test entry. In the field Word edit
a word of a language like “apple”.  In the field Word of the translation, edit
“manzana” (English-Spanish in this example). Choose for “apple” the Word
type “substantive” (noun) and for “manzana” the Word type “feminine”. In
the field alternate can you edit the same word with an other spelling.
Example: “who’s”  in the Word field and “who is” in the alternate field. In
the field Example can you edit a example sentence for the word. When  the
English word is “seven” edit in the Spanish field Word “siete” and in the
Spanish Example field “¿Y a qué  hora empieza la película? A las siete y
cuarto.”.
When a word has other translations, edit this translations in the fields Other
translation. Example (German-English): The German word is “laut” and the
word type is”adverb”, then is the English word “loud” and the word type
“adverb”. The first other translation for “laut” is “according to”(word type
preposition) and the second translation is “sound” when the first character
of “laut” change from lower case to upper case -> “Laut”.
But do not edit all other translations, do only edit the important alternates. 

You can recording a sound for this test. Click on the record button  to
start the recording. The record window of the MacOS appears. Click
on the record button. After recording click the stop button.
Then click on “Save”. 

Or drag & drop a sound clip on the play button . 

TIP

WordCoach compress the sound 3:1. But do not use the
recording function to much. The database need some kilo
bytes memory for storing the sound.



Picture Test
Press  and 2 to create a “Picture Test” test entry. Drag & drop a picture
clip or a picture file (PICT format) on the picture field. There are some
ways to fill out the text fields.

Example 1: The picture is an apple. English-Spanish
In the English question field edit “What is it?”. In the English
answer field edit “apple”.  Then edit in the Spanish question
field “¿Qué es esto?” and in the Spanish answer field edit
“manzana”. When the test appears, you see the apple and
the question “What is it?”. You must edit as answer
“manzana”. When you are learning with an other language
direction, you get the question “¿Qué es esto?”, answer then
with “apple”.

Example 2: The picture is an apple. English-Spanish
Do not edit a question in the question field. Fill in the translation for the
answer.
English question and answer field edit “apple”. And in the Spanish
question and answer field edit “manzana”.

Multiple Choice Test
Press  and 3 to create a “Multiple Choice” test entry. You can edit a
multiple choice test for both languages. There is only one test visible, but
you can switch the fields to the other language with the language direction
buttons. You can fill the question field with a question in your native
language and the answers in the foreign language. Or fill both in the same
language. 
Edit one or more answer fields with a correct answer and mark the check
box. In the other fields edit a wrong answer.

Comment Text
Press  and 4 to create a “Comment Text” entry. You can edit a comment
text for both languages. There is only one text field visible, but you can
switch the field to the other language with the language direction buttons.

Memory Game 
Press  and 5 to create a “Memory Game” entry. Edit 5 word pairs in the
text fields. Or press one of the wizard buttons, to fill the fields
automatically.
1. fill the fields with words of all previous and the current unit.
2. fill the fields only with words of the current unit



Import Dictionary
 
Before you can make a new dictionary, you must create one or two text
files (1. Translation-Original; 2. Original-Translation ) with the translations.
With this text files can WordCoach create a dictionary.
Select the menu item "File>Import Dictionary " . A file dialog appears. Edit
the file name for the new dictionary. Then appears a window with two
popup menus. With this pop menus you can choose the languages for the
dictionary.
Now select the text file with translation-original entries (or cancel).
For a German-English dictionary you must have a sequence like this.

* and  und 

An other file dialog appears. Select now a file with original-translation
entries.
For a German-English dictionary you must have a sequence like this.

* und  and 

Now you must edit the number of entries in a lesson. Then the program
will compare all entries, answer ok or cancel. While the program is
comparing all entries, it looks for other translations of an entry. If so, it
expand the entry with this translation.

Example:
the  der 
the  die 
the  das 

After comparing, the entry the/der looks like: the ->der Other:(die; das;)
At the end of creating a dictionary, edit the filename of your dictionary
ending with ".dic" and switch to the folder "Dictionaries". Click on Save and
wait.

Format 

You must write the words in a special format. So the program can read the
text file correctly. Separate the entries with the line-end character (Return) (

) and the elements of an entry with the tabulator-character ( ).

Example 1:
und  and 
oder  or 

In example 1 is the minimal number of elements in an entry. One word of
language A (Position 1) and one word of language B (Position 2). The next
both elements are the word types of the words.



Example 2:
Haus   house  n   s 
Baum   tree  m   s 

(s=substantive;m=masculine;f=feminine;n=neutrum;v=verb ...........)
At position 5 and 6 can you write example sentences for the words.
Example 3:
fischen  fishing  v v Ed und John fischen.  Ed and John are fishing. 
Dividing in lessons make the program automatically. Would you make a
new lesson between two lessons, then paste a lesson separator ( § ) in your
text file.

Example 4:
Haus   house  n   s 
Baum   tree  m   s 
§ 
und  and 
oder  or 

Birgelen, the 19. März 1999

Edwin Bühler

 



Index

68k Mac  . . . . . . . . . . . . . . . . .  4
Adverb  . . . . . . . . . . . . . . . . . .  7
Alternate field  . . . . . . . . . . .  7
Answer  . . . . . . . . . . . . . . . . . .  6
Answer field  . . . . . . . . . . . . .  8
Apple  . . . . . . . . . . . . . . . . . . .  8
Automaically  . . . . . . . . . . . .  8
Automatically  . . . . . . . .  6, 10
CFM-68k Additions  . . . . . . .  4
Change  . . . . . . . . . . . . . . . . . .  5
Character  . . . . . . . . . . . . . . .  9
Check box  . . . . . . . . . . . . . . .  8
Command-key  . . . . . . . . . . .  5
Comment Text  . . . . . . . . . . . .  8
Compare  . . . . . . . . . . . . . . . .  9
Compress  . . . . . . . . . . . . . . . .  7
Create  . . . . . . . . . . . . . . . .  5, 9
Current unit  . . . . . . . . . . . . . .  8
Dictionary  . . . . . . . . . . . . . . .  9
E-Mail  . . . . . . . . . . . . . . . . . .  3
Elements  . . . . . . . . . . . . . . . .  9
English-Spanish  . . . . . . . . .  8
Entry  . . . . . . . . . . . . . . . . . . . .  9
Example  . . . . . . . . . . . . . . . .  10
Fax  . . . . . . . . . . . . . . . . . .  3, 10
Feminine  . . . . . . . . . . . . .  7, 10
Flags  . . . . . . . . . . . . . . . . . . . .  6
Foreign  . . . . . . . . . . . . . . . . . .  8
GUI Language  . . . . . . . . . . . .  5
Import Dictionary  . . . . . . . .  9
Installation  . . . . . . . . . . . . . .  4
Interface  . . . . . . . . . . . . . . . .  5
Language chooser  . . . . . . . . .  5
Language Chooser  . . . . . . . .  7
Language direction  . . . . .  6, 8
Last dictionary  . . . . . . . . . . .  5
Lessons  . . . . . . . . . . . . . . . . .  10
Load  . . . . . . . . . . . . . . . . . . . .  5
Logged user  . . . . . . . . . . . . . .  5
Login  . . . . . . . . . . . . . . . . . . . .  5
Login first time  . . . . . . . . . . .  5
MacOS  . . . . . . . . . . . . . . .  7, 10
Manzana  . . . . . . . . . . . . . . . .  8
Masculine  . . . . . . . . . . . . . .  10
Memory  . . . . . . . . . . . . . . . . .  7
Multiple Choice Test  . . . . .  8
Name  . . . . . . . . . . . . . . . .  5, 10
Native  . . . . . . . . . . . . . . . . . .  8
Neutrum  . . . . . . . . . . . . . . . .  10
New  . . . . . . . . . . . . . . . . . . . .  6
New Dictionary  . . . . . . . . . .  7
Noun  . . . . . . . . . . . . . . . . . . . .  7
Online Order Processing  . . .  3
Open Dictionary  . . . . . . . . .  6
Original-Translation  . . . . .  9

Other translations  . . . . . . .  7
Password  . . . . . . . . . . . . . . . .  5
Phone  . . . . . . . . . . . . . . . . . . .  3
Picture  . . . . . . . . . . . . . . . . . .  8
Picture Test  . . . . . . . . . . . . . .  8
Play button  . . . . . . . . . . . . . .  7
Popup menu  . . . . . . . . . . . . . .  9
Position 5  . . . . . . . . . . . . . . .  10
Preposition  . . . . . . . . . . . . . .  7
Program interface  . . . . . . . .  5
Question  . . . . . . . . . . . . . . . .  6
Question field  . . . . . . . . . . .  8
Record button  . . . . . . . . . . . .  7
Record window  . . . . . . . . . . .  7
Recording  . . . . . . . . . . . . . . .  7
Result database  . . . . . . . . . .  5
Result field  . . . . . . . . . . . . . .  6
Return  . . . . . . . . . . . . . . . . . .  9
Same  . . . . . . . . . . . . . . . .  8, 10
Save  . . . . . . . . . . . . . . . . . . . .  7
Sentences  . . . . . . . . . . . . . . .  10
Separator  . . . . . . . . . . . . . .  10
Sound  . . . . . . . . . . . . . . . . . . .  7
Sound clip  . . . . . . . . . . . . . . .  7
Special format.  . . . . . . . . . .  9
Start with  . . . . . . . . . . . . . . .  6
Status bar  . . . . . . . . . . . . . . .  6
Stop button  . . . . . . . . . . . . . .  7
Substantive  . . . . . . . . . . .  7, 10
Switch  . . . . . . . . . . . . . . . .  6, 8
Switches  . . . . . . . . . . . . . . . .  6
Systemextensions  . . . . . . . . .  4
Tabulator  . . . . . . . . . . . . . . .  9
Test  . . . . . . . . . . . . . . . . . . . . .  6
Text file  . . . . . . . . . . . . . .  9-10
TIP  . . . . . . . . . . . . . . . . . . .  6-7
Translation  . . . . . . . . . . . . . .  8
Translation-original  . . . . . .  9
Translation-Original  . . . . .  9
User Name  . . . . . . . . . . . . . .  5
User Password  . . . . . . . . . . .  5
Users  . . . . . . . . . . . . . . . . . . .  5
Verb  . . . . . . . . . . . . . . . . . . .  10
Visible  . . . . . . . . . . . . . . .  8, 10
Web  . . . . . . . . . . . . . . . . . . . .  3
What is it?  . . . . . . . . . . . . . .  8
Wizard  . . . . . . . . . . . . . . . . .  8
Word  . . . . . . . . . . . . . . . . . . .  7
Word pairs  . . . . . . . . . . . . . .  8
Word to Word  . . . . . . . . . . .  7
Word type  . . . . . . . . . . . . . . .  7
Word types  . . . . . . . . . . . . . .  9
Words  . . . . . . . . . . . . . . . . .  10
§  . . . . . . . . . . . . . . . . . . . . . .  10
˛ and 1  . . . . . . . . . . . . . . . . . .  7

˛ and 2  . . . . . . . . . . . . . . . . . .  8
˛ and 3  . . . . . . . . . . . . . . . . . .  8
˛ and 4  . . . . . . . . . . . . . . . . . .  8
˛ and 5  . . . . . . . . . . . . . . . . . .  8
˛ and L  . . . . . . . . . . . . . . . . . .  6
˛ and N  . . . . . . . . . . . . . . . . .  6
˛ and O  . . . . . . . . . . . . . . . . . .  6
¿Qué es esto?  . . . . . . . . . . . .  8


